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MINICURSO DE DISENO DE
PLACAS DE CIRCUITO
IMPRESO (PCB)
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Para descargar la presentacion y material adicional del minicurso
acceder aqui:
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DOCENTE

Andrés Fernando Ordoénez Hurtado
Departamento de Electronica, Instrumentacion y Control
afordonez@unicauca.edu.co

* Ingeniero en Electronica y Telecomunicaciones, Universidad del
Cauca, 2012.

* Disenador de Circuitos Integrados de Radiofrecuencia, Programa
de Entrenamiento de Disenadores de Circuitos Integrados CI
Brasil. 2015.

 Master en Ingenieria Electronica, Universidad Federal de Santa
Catarina, Brasil, 2017.
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OBIJETIVO

El objetivo de este minicurso es presentar a los asistentes una
introduccion sobre los conceptos basicos y las técnicas elementales
de diseno de Placas de Circuito Impreso (PCB, Printed Circuit Board)
asistido por computador, a través de la herramienta de software

KiCad EDA.
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¢QUE ES UN CIRCUITO?

Consiste en una agrupacion de

10 V
elementos interconectados entre 5 O 2
si a través de los cuales puede
fluir una corriente eléctrica que 2 A 20 O 30 O <*>5A
puede ser generada por una
fuente de energia, bien sea de r 5 i

forma directa (DC) o alterna (AC). :
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ELEMENTOS CIRCUITALES

Entre los elementos circuitales
mas comunes se cuenta con:

. . 7 TIP41 }lx
* Resistencias @ v TL
<>. Ll 2N3904 i

 Condensadores
* Inductores
e Diodos

* Transistores =
e Circuitos Integrados

1000 pF /=<
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PLACA DE CIRCUITO IMPRESO

Consiste en una superficie
construida por caminos o rutas
metalicas (cobre) laminadas sobre
una base no conductora (fibra de
vidrio), usada para conectar
eléctricamente y sostener un
conjunto de componentes
electronicos.
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PLACA DE CIRCUITO IMPRESO
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TIPOS DE PCB

Se pueden clasificar de acuerdo al
numero de capas:

* Una sola capa (Unilayer)
e Multicapa (Multilayer)

Total Height (0.8mm)

Core (0.264mm)

Top Layer —= Prepreg (0.1mm)

GND —> Core (0.264mm)
+3.3Y —

Bottom Layer —=
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TIPOS DE PCB

Se pueden clasificar de acuerdo al
tipo de soldadura de componentes:

* Tecnologia de Agujeros Pasantes
(THT, Through Hole Technology)

* Dispositivos de Montaje
Superficial (SMD, Surface Mount

D e Vi C e S ) Componente THD axial
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FABRICACION DE PCB

Proceso Artesanal

e Corrosion Quimica
e Revelado
e CNC
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FABRICACION DE PCB

Proceso Industrial

_microcircuitos

pcb - smt - @ -RoHS

 Fabricacion Nacional
e Fabricacion Internacional

{?}CJLCPCB lIEasylEDA R A

PCBWQY PCB Prototype the Easy Way
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SOFTWARE DE DISENO DE PCB

Autodesk Eagle:

~ AUTODESK

- o i EAGLE
Herramienta de diseno CAD
para la elaboracién de PCB. .. — o
EAGLE dispone su software i

con licencia estudiantil, ; | i
aunque con algunas T °©
restricciones para el tamafio w :
de la placa (drea de 10 cm x B
10 cmy maximo 2 capas).

X SEMINARIODE - G %

AUTOMATICA o~

27 AL 30 DE SEPTIEMBRE 49{{ fios ’ d




SOFTWARE DE DISENO DE PCB

Altium Design: v Allhum

Designer.

Altium Designer es un

. [ A Altium Designer = (m] X

S O tWa r‘ ‘ IS‘ l lO ‘ \[* DXP File Edit View Project Design Tools Reports Window Help D:\Designs\DTO1\One-Wire_Write_~ &3 ~ @z K-=2-=" -~ 3~
DNEH SN CEE R Q@ & @~ |Hxx(4t 27| Q : [No Variations] - @

I . I f Navigator w 3 x [ (6) One-Wire_Write_Read.SchDoc ~ 2 B8 B C

e a tO I Ve e O C a O a [ show Signals eractive Navigation E ) & é

Documents for DTO1.PrjPCB ~ &

V 4 [ | Compiled Schematic Documents g

roductos electréonicos de

[ DT01_ID (DTO1_ID.SchDo¢) T

{4 U_DT01_Mounts (DT01_Mounts.... ]

-4 U_Hard_Soft_JTAG_Socket (Har

iFIC2(IC1ID) DS2406  Compon...
SEIC3(C1_1.. MAX4561 Compon...

los sectores aeroespacial, .. UT
automotriz y de electrénica
de consumo, entre otros. o e il

R30

1FIC1A (IC1_C... MC/ARM... Compon...
Local To Document

Local To Document
== NetlC5_8 Local To Document
# ==NetlC5 10 Local To Document ¥

Componen... | Designator | Type ~
= IC3-1  Passive Pin
—1C3-2  Passive Pin o
—a IC3-3  Passive Pin i
< >
Projects = Navigator Editor U_One-Wire_Write_Read j)] _-{ &PY | Mask Level | Clear -: > M Top Layer M Bottom Layer 1.3DB(ZPY Snap Mask Level ' Clear

Output  To-Do

x SEMINARIO DE 6SA c @ Storage Manager Messages
AUTOMATICA X:35.4mm Y:14.2mm  Grid: 0.1mm (Hotspot Snap (All Layers)) Text "DT01.02" (41.158mm,17.973mm) Bottom Overlay
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SOFTWARE DE DISENO DE PCB

KiCAD:

KiCad es una herramienta
software libre para |Ia
automatizacion del diseno
electronico. Facilita el
diseno de esquematicos
para circuitos electronicos
y su conversion a PCB.
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KICAD

Existen herramientas dentro de KiCad para crear una lista de materiales,
ilustraciones, Gerber y vistas 3D de la PCB y sus componentes.
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KICAD

¢Por qué KiCad?

* No hay costos asociados a
licencias.

 Soporte para diferentes sistemas
operativos.

« Comunidad en linea extensa.

e Soporte en diferentes idiomas.

* Libreria de componentes extensa.

* Etc.
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:_Iﬂ BLOG DISCOVER~- COMMUNITY~ HELP~- CONTRIBUTE~ SPONSORS~ LIBRARIES- DOWNLOAD ABOUT~ Donate

KiCad EDA

A Cross Platform and Open Source Electronics Design
Automation Suite

H Documentation & Download A ¢ & E See what's new

https://www.kicad.or ﬁ}
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https://www.kicad.org/

KICAD

Download

KiCad 4.0.7 was released in August 2017. See the announcement on the blog. Details on the

availability for your platform can be seen for each of the platforms below

Select your operating system or distribution

@
0 ‘ 1]
Gl - =
Ubuntu MacOS Windows
El foro de KiCad en castellano

Debian Linux Mint Arch Linux

29 de Septiembre de 2022, 00:30:24

0,

;ﬁm [mﬁﬁa £ Buscar

El foro de KiCad en castellano

Y

Pait

Fedora openSUSE Flatpak

O

~ Sobre el foro de KiCad Mensajes: 101 Ultimo mensaje: 17 de Febrero de 2021, 12:47:57
¢Tienes algin comentario que hacer sobre el foro? Hazlo aqui. Temas: 20 error Flatcam por jlitter

- Novedades en KiCad Mensajes: 301 Ultimo mensaje: 05 de Septiembre de 2022, 16:23:35
Novedades en el desarrollo de KiCad Temas: 53 Re:Planos y margenes por ElektroQuark e \ ’ \/
KiCad en castellano Mensajes: 100 Ultimo mensaje: 11 de Noviembre de 2020, 07:36:39 - s -
Mejoremos la traduccion de KiCad. Sugerencias y errores en la traduccion. Temas: 16 Re: Ayudar a traducir Ki... por ElektroQuark -, GNU Guix Gantoo
Sabayon Source Code
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KICAD

i) KiCad 6.0.7 Setup — X

Choose Components
' a Choose which features of KiCad 6.0.7 you want to install.

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select components to install:  |.[¥] Libraries R Pesé"f’tf‘?h
Schematic libraries
-[v] Footprint libraries

----- Footprint 3d mode
-[¥] Footprint wizards
-[¥] Demonstration projec

-[v] File associations >

< >

Space required: 6.0 GB

< Back Next > Cancel
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EESCHEMA

[ [ pic_programmer /] (CAProgram Files\KiCad\share\kicad\demos\pic_p [Read Only] - ol

File Edit View Place Preferences Tools Help

= = o) aacRlE PANCSIE-GF Qoo AR I Ao

[
3
T I T Y T T L I -
i3
-
A i v
X
8| ® A
o PATA-RR7.
\ AD~
BL=DATA=IN —SL0Ck-A08 b, -
3 i 20
i VPP (13V) power ! »
? S A2, v ’ DA
PL=CI0LK=0UT ,_(:iip_ ' e —tHy--C10CC-REA, X len & B O S e | -
S e Y A 22w } '
g 5[] ook j_.;-...-um > f i - il £
! i v Pt i i
wt o 0@ e £
3 2 E o 4,@‘ i =
[ _{ ;l:'“ Laful=8 ronst 10 wr = a3 } | C
o i
L —Cii- ! 1
|
H i
il i DI.DIOQIBAMEIICH ©
! - 4 rogrammes will converter
Site. oA T _Daie. 05 fan 2016 [Rev- 2
KiCad LDA " Viced (015-00=18 BIR 6057, G o30ucdi]-pmooucd | 10 /27
T T T b T I 5 1 (!
<
Done Loading <pic_sockets.sch> Zi21 X307.34 Y205.74 dx307.34 dy 205.74 dist 369.85 Q

W
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PCBNEW

E: Pcbnew (2015-08-16 BZR 6097, Git b384c94)-product C:\Users) (o] -2015.07. \hackrf-one\hackrf-one.brd

Fle Edit View Place Route Preferences Dimensions Tooks DesignRules Help
1 I3 i » a5 &
R All- 2 AQAR G G¥ Wxewn - BEH S @

Track: 0279 mam (11.00 mils)* v 69 mm (270 mis)/ 033 mm (130 mils) * v| S2= | Gric: 12700 mm (5000 miks) v| Zoom3d
=

o]

556866 90 3 C
ee oo

\_\
&
[l
<)
2
1k
4
<

1
e

Krgo BB G o

3
=

Connections  Unconnected
12 0

Z34 X 193.040000 Y 173.990000 dx 193.040000 dy 173.990000 dist 259.879

> G %

- oW

Visbles

Layer | Rendes

mVICF
@0c
m_cG
pmvice
W V/FAdhes
M VIBAdhes
WV FPaste
B v/BPaste
B VIFSas
M [V BSlkS
WV FMask
B VB Mask
W V) Cnts User
O V) Edge.Cuts
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3D VIEWER

Ze2t3 @

File Preferences

- @ RACR Sk o R

NG

dx-0.10 dy 0.00 Zoor: 230

N
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CONCEPTOS CLAVE

Esquematico: Diagrama que representa oursa 1 4
una visualizacion de las interconexiones E 2 st B 7 ]
de los elementos del circuito a realizar SLEEP

R13
F1-STEPD———+—1 sTEP Phe
E1-DIRD————14 pIR i

12 2. [ |rP2
g VREG 2\ REFES " k7
ROSC o
T Z
P O
R12
0
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CONCEPTOS CLAVE

Layout: Corresponde al diseno fisico de la
placa de circuito impreso.
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CONCEPTOS CLAVE

Pad: Zona de contacto en la PCB de un
pin o terminal de un componente.

Huella (Footprint): Disefio del conjunto
de pads de un componente en particular.
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CONCEPTOS CLAVE

Agujeros de Montaje (Mounting
Holes): Agujeros de una PCB
dispuestos para realizar su montaje
con tornillos.
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CONCEPTOS CLAVE

TOP LAYER
MIDLAYER 1

MIDLAYER 2

Layer: Cada una de las capas de .
diseno que corresponde a un proceso MIDLAYER 3
de fabricacion de |la PCB. FLANE 2

MIDLAYER 4

BOTTOM LAYER
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CONCEPTOS CLAVE

Net: Segmento de linea que comunica
dos componentes o partes de |a PCB.

Via: Seccion de metal utilizada para
transferir una net entre diferentes

capas de la PCB.

Through hole Buried via Blind via
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CONCEPTOS CLAVE

Mascara de Soldadura (Soldermask):
Mascara que contiene ranuras en los
pads para la aplicacion de soldadura.
Mascara de Serigrafia (Silkmask):
Mascara que incluye los nombres,
valores y  simbolos de los
componentes.
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TUTORIALES BASICOS

[mcad Docs Q 6.0 ~ ESPANOL ~
. |(j| Iw -w=
[ T

Alternate formats Alternate for Alternate formats

B PDF B PDF B PDF
iHLII L
PCB Editor Gerber Viewer Drawing Sheet Editor

[1] KiCad Documentation. Disponible en:
AUTOMATICA 55 |5 https://docs.kicad.org/. s
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https://docs.kicad.org/

TUTORIALES BASICOS
#» HACKADAY

HOME BLOG HACKADAY.I0O TINDIE HACKADAY PRIZE SUBMIT ABOUT September 28, 2022

CREATING A PCBIN
EVERYTHING: KICAD, PART 1

by: Brian Benchoff

fYY @ i November 17, 2016

2 OIQ) [FoCo & FOI 920 g 1016 755" § £ 10I6
§o (g)|O| ::lq%,:]oo(g”Ol "':'O(O)'OI 50-0

anite Wesley ﬂm /
0 “' )FO 00 [
= | ;
I" = (
&> 00 000 2—2 ° 1%
J) > 22 Go00

@® 72 Comments

anhe We l ey '

[2] Hackaday, Creating a PCB in Everything: KiCad. Disponible:

https://hackaday.com/2016/11/17/creating-a-pcb-in-everyth
AUTOMATICA ;- |- ing-kicad-part-1/.

27 AL 30 DE SEPTIEMBRE J 94_1 fios
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https://hackaday.com/2016/11/17/creating-a-pcb-in-everything-kicad-part-1/
https://hackaday.com/2016/11/17/creating-a-pcb-in-everything-kicad-part-1/
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Find a Retailer Need Help? «
parkfun SHOP BLOG SERVICES E 0 LOG IN REGISTER
TART SOMETHING e
=— PRODUCT MENU m ALACARTE ~ TODAY'S DEALS  SPARKEY  FORUM

HOME TUTORIJAL

Beginner's Guide to K|Cad

CONTRIBUTORS tﬁ“ \TE
Q FAVORITE |15 Dn

Sections

Introduction
Introduction

KiCad Project Window
If you're like me and you've decided to take the plunge from EAGLE PCB to KiCad it can be really jarring. EAGLE had

many quirks and rough edges that I'm sure | cursed when | first learned it back in 2005. Since then EAGLE has become
a second language to me and I've forgotten all the hard bits. So as you migrate to KiCad remember to take breaks and
breathe (and say 'Key-CAD' in your head). You'll be dreaming in KiCad in no time!

Setting Up Schematic Component Libraries
Editing a Schematic

Editing a PCB Layout

Running Design Rule Check
Exporting Gerbers
Creating a Custom KiCad Footprint Library

Creating Custom KiCad Schematic Components

[3] Sparkfun, Beginners Guide to KiCad. Disponible en:

https://learn.sparkfun.com/tutorials/beginners-guide-to-kica

d/all.

y solidaria 4
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https://learn.sparkfun.com/tutorials/beginners-guide-to-kicad/all
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EJEMPLO EN KICAD

Generador PWM con NE555:

* Cl: NE555 40 .
* R, R:1kQ . %
Sk
* POT: 10 kQ T tnaras e ;
* C,:1 pF (Electrolitico) JAN \V4 2 wesss
* C,:10nF (Ceramico) AW
. LED1: Diodo LED Kmm
* Q,: Transistor 2N2222 Tw" ‘-1=1°"F

. D1' DZ: Diodo 1N4148
. CON1: Entrada de bateria
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EJEMPLO EN KICAD
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EJEMPLO EN KICAD

Pasos para la Creacion de PCB:

1.
2.
3.
4.
5.
6.
7.
8.

X SEMINARIODE & G =

Creacion de Proyecto

Disefio de Esquematico (Eeschema)
Anadir Anotaciones

Verificacion de Errores (ERC)
Seleccion de Huellas

Diseno de Rutas (Pcbnew)
Verificacion de Errores (DRC)
Generacion de Gerber.

e X
: %&E%«Zﬂ?ﬁ*

Universidad
del Cauca
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EJEMPLO EN KICAD
The Kicad desigh workflow

Schematic
m—. Eeschema library
editor

PCB
footprint
editor

Netlist

Footprint
Pcbnew library
editor

Gerber Gerber |
fles Test Fabrication 3

X SEMINARIO DE
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EJEMPLO EN KICAD

-

ile

e

- MKl

[no project loaded] — KiCad 6.0

View Tools Preferences Help
Project Files

N E WY

il

/1N

Schematic Editor
Edit the project schematic

Symbol Editor
Edit global and/or project schematic symbol libraries

PCB Editor
Edit the project PCB design

Footprint Editor
Edit global and/or project PCB footprint libraries

Gerber Viewer
Preview Gerber files

Image Converter
Convert bitmap images to schematic symbols or PCB footprints

Calculator Tools
Show tools for calculating resistance, current capacity, etc.

Drawing Sheet Editor

Edit drawing sheet borders and title blocks for use in schematics and PCB designs

Plugin and Content Manager
Manage downloadable packages from KiCad and 3rd party repositories

Local path: monitoring folder changes

universidad
de excelencia
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EJEMPLO EN KICAD

@ Create New Project X
Save in: KICAD vl @ F 2 R
i Name a Date modified Type
. 6.0 9/11/2022 9:14 PM File f¢
CHick access Control 6/28/2022 4:10 PM File fc
- EjemploMinicurso 9/23/2022 9:51 PM File fc
. LED_Blink 9/23/2022 8:43 PM File f¢
Desktop
™
Libraries
My PC
L‘”f < >
Network
File name: PWM555 v Save

Save as type: KiCad project files (" kicad_pro) v Cancel

X SEMINARIODE - G %

Create a new folder for the project Por una
universidad
de excelencia

AUTOMATICA .~

7
27 AL 30 DE SEPTIEMBRE /9 ?/fﬁ( .

niversidad
y solidaria del Cauca




EJEMPLO EN KICAD

fED PWMS55 [PWMS55/] — Schematic Editor

B&DOADOCIAPHCRRAAARIE | == ARRE BrIED H S
o gl

Is
o

=& 3T+ UNNIFT|5

3

[ ¥ [

v
<

Z0.72 X205.74 Y -6.35 dx 205.74 dy -6.35 dist 205.84 grid 1.27 mm

X SEMINARIODE - G %
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EJEMPLO EN KICAD

File -> Page Settings

Page Settings X
Paper Drawing Sheet
S File: ™
A4 210x297mm v
Orientation: Title Block
Landscape v

Number of sheets: 1 Sheet number: 1

2794 : Issue Date: I 2022-09-28 ’ <<<| | 9/28/2022 = | [JExport to other sheets

431.8 Revision: I 01 I [[J Export to other sheets
[ Export to other sheets Title: | Generador PWM con NE355 ' [[JExport to other sheets
Company: | Universidad del Cauca ’ [[]Export to other sheets

ey Comment1: I Andrés Fernando Ordofiez Hurtado ] [[] Export to other sheets
Comment2: I l [[J Export to other sheets

Comment3: | ' [[] Export to other sheets

Comment4: | | [[JExport to other sheets

Comment5: | ' [C]Export to other sheets

Comment6: | l [[J Export to other sheets

%. — Comment7: l ' [[] Export to other sheets
Comment8: | | [[J Export to other sheets

Comment9: | ' [[]Export to other sheets

X SEMINARIODE - G % Cancel
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EJEMPLO EN KICAD

@ *PWM555 [PWM555/] — Schematic Editor . X
File Edit View Place Inspect Tools Preferences Help

A DT DS ClAag|lcaa@QaQ®R|E 1| REZ B ED RS
o I
. S
2 L
* b /
B /
= 2
...x
Andrées Fernando Ordofiez Hurtado _+
Unlversidad del Cauca
Sheet: / -
File: PWM555 kicad_sch 0 B
Title: Generador PWM con NES555 e
Size: A4 | Date: 2022-09-28 Rev: 01 ga
KiCad E.D.A. kicad (6.0.7) Id: 1/1 >
[ | 5 | 6 Fﬁ
Wl T
Z242 X227.33 Y142.24 dx 227.33 dy 142.24 dist 268.16 grid 1.27 mm Select item(s)

X SEMINARIODE - G %
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EJEMPLO EN KICAD

Place -> Add Symbol

Choose Symbol (17365 items loaded) X
Q 555
- u o| NE5S55P
Item Description 5
: 2 w 3
v 4xxx_|EEE 4xxx series |[EEE symbols —TR 2 QF——
4555 =
v Timer Assorted timer devices 5 cy DIS 7
LM555xM Timer, 535 compatible, SOIC-8
LM555xMM Precision Timers, 555 compatible, VSSOP-8 4 e 3]
: —dR = THRI——
LM555xN Timer, 555 compatible, PDIP-8 (W]
NAS555D Precision Timers, 555 compatible, SOIC-8 i
NASS5P Precision Timers, 555 compatible, PDIP-8
NE555D Precision Timers, 555 compatible, SOIC-8
NESS5P Precision Timers, 555 compatible, PDIP-8 {Deiatiel £2 R Wi %
SAS555D Precision Timers, 555 compatible, SOIC-8
SA555P Precision Timers, 555 compatible, PDIP-8
SES55D Precision Timers. 555 compatible. SOIC-8 Y
< >
~
NE555P
Precision Timers, 555 compatible, PDIP-8
Keywords: single timer 555
Reference U? DIP—-8_W7.62mm
Footprint Package_DIP:DIP-8_W7.62mm
v
Select with Browser Place repeated copies[ | Place all units Cancel
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EJEMPLO EN KICAD

fED) PWM555 [PWM555/] — Schematic Editor - X

File Edit View Place Inspect Tools Preferences Help

A& D5 0| PR CRQAARCQAAIE T |2 2> AlRZ BoHED EE

P 4

WCC PWR_FLAG

[
ﬁ] E"l. IS D R2

o2
1N414B

oy

|83 TP+ X UNNIHV|

I

£

Ak L

=1

Z i

1N414B
44 POTL

Screw_Terminal_01x02 500k

@1
el2

L=
s
2
[

u1
NEESSP

3 Qi

‘Y
2k / PH22228
GV 5 oy DIs|Z e
L
il THRTE

=2 i PWR_FLAG

GND

GND

o
E
=
(=2
I:
=
Lienp

v
<

Z1.61 X 167.64 Y 50.80 dx 167.64 dy 50.80 dist 175.17 grid 1.27 mm
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Edit Value (V)

X SEMINARIO DE

AUTOMATICA
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EJEMPLO EN KICAD

Edit Value Field X
Value: | 1k
Visible
Position X: | 203.2 | mm [ italic Orientation: | Horizontal v
Position Y: ‘ 78.7399 I mm (] Bold H Align: Left v
Text size: I 1.27 ! mm V Align: Center v
Edit Value Field X
Value: | 1N414g]
Visible
Position X: \ 132.08 } mm (] Italic Orientation: Vertical v
Position V: | 87.6299 | mm [1Bold HAlign: | Left v
Textsize: [ 1.27 | mm V Align: Cerder: |

Cancel
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EJEMPLO EN KICAD

Codigos Usados para Elementos:

* R: Resistencia

C: Condensador

e L:Inductor
 D:Diodo

Q: Transistor

U: Circuito Integrado
P: Pin

e X: Cristal
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EJEMPLO EN KICAD

Tools -> Annotate Schematic

Annotate Schematic

(O Current sheet only
(O Selection only

Options
(®) Keep existing annotations

(O Reset existing annotations

Annotation Messages:

Order
(® Sort symbols by X position

(O Sort symbols by Y position

Numbering

NS

(@) Use first free number after: D

() First free after sheet number X 100
() First free after sheet number X 1000

Show: [“] All Merrors @I M Wamnings @I [ Actions

Clear Annotation

Infos Save...

Close
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EJEMPLO EN KICAD

@ *PWM3555 [PWM3555/] — Schematic Editor =

File Edit View Place Inspect Tools Preferences Help

A& DBMEODC|P%ICRAARAIE T |2 2> A RREZ BsED B S

“eee ~
e
e
veee

|

X

.o

>
-

t -

o
i VCC
Ll >
mm i
L
Ri =
* = R2 /
B ) !
D1 D2
b Y ineten 1H4148 N
" POTL D3
S:rew_TermlnaiL01x02 500k i E LED =
2 o NESSSP _+
2he 3 Qi3 B
= 2 PHN22224 A
5 oy oistL A
o 7 L_iqg S TtHrlE B>
10Qn 10n 5
3 A
— %
R A
GND ’__g)
3
v
<
Line Type Line Style Connection Name Assigned Netclass
Wire solid GND Default
Z1.61 X182.88 Y 46.99 dx 182.88 dy 46.99 dist 188.82 grid 1.27 mm Select item(s)
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EJEMPLO EN KICAD

Inspect -> Electrical Rules Check

Electrical Rules Checker X

Messages Violations

V Error: Input Power pin not driven by any Output Power pins
Symboel U1 [NE555P] Pin 1 [GND, Power input, Line]

v Error: Input Power pin not driven by any Output Power pins
Symbel U1 [NE555P] Pin 8 [VCC, Power input, Ling]

Show: [JAll Errors o Warnings n [] Exclusions Save...

Delete Markers Run ERC Close
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EJEMPLO EN KICAD

B0 *PWMS555 [PWMS55/] — Schematic Editor - X

BA&DER DO CI2%CRARARIET|C 2> AlRRE TosED B S

A
k
sess
in

i

X SEMINARIO DE

AUTOMATICA
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- VYCC PWR_FLAG J;
mil :[>
mm
DT T vCe <
+ [5 . /
ik
. DI R2
B> [[= /
¥ O D2 QI
IN4L4B 1N4148
I POT1 AV R
Screw_Terminal_01x02 500k N LED
1 U1 E '+
NESS5P
0| a¢] A
0 i o3 T & -
= s/ Przazos B
A 5 fev DisfZ [
+ 2
1 4 = & A
o 1w | —dr 2 THR
~i|
1 %
. GND . l‘_‘_&",
- l PWR_FLAG 0t
GND
ol T
< >
7172 X 17653 Y 48.26 dx 176.53 dy 48.26 dist 183.01 grid 1.27 mm Select item(s)

> G %
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EJEMPLO EN KICAD

Tools -> Assign Footprints

:E\_ Assign Footprints

File Edit Preferences Help

([0 | = = |

Footprint Libraries

Audio Module A 1 Cl
Battery 2 c2
Button_Switch_Keyboard 3 Dl
Button_Switch SMD 4 D2
Button_Switch_THT 5 D3
Buzzer_Beeper € Jl
Calibration_Scale 7, POT1
Capacitor_SMD 8 QL
Capacitor_Tantalum SMD 9 Rl
Capacitor_THT 10 R2
Connector 11 Ul

Connector_AMASS
Connector_Amphenol
Connector_Audio
Connector_BarrelJack
Connector_Card
Connector_Coaxial
Connector_DIN
Connector_Dsub
Connector_FFC-FPC
Connector_Harting
Connector_Harwin
Connector_HDMI
Connector_Hirose
Connector_IDC
Connector_JAE

< >

No Filtering: 12289

Library location: unknown

»\f‘@ *:6 ‘ FootprintFihers:E:a Ea H:l

Symbol : Footprint Assignments

10n :
lu :
1N4148 : Diode_THT:D_DO-35_SOD27_P7.62mm_Horizontal
1N4148 : Diode_THT:D_DO-35_S0D27_P7.62mm Horizontal
LED :
Screw_Terminal 01x02 :
500k :
PN2222A : Package_TO_SOT_THT:T0-92_Inline
1k :
1k :
NESSSP : Package_DIP:DIP-S_W7.62mm

Filtered Footprints

1

mo W

@ - o

[

10
11
12
13
14
15
1é
X7
18
19
20
21
22
23
24
25
26

Apply, Save Schematic & Continue

Audio_Module:Reverb_BTDR-1H
Audio_Module:Reverb_BTDR-1V
Battery:BatteryHolder_ Bulgin BX0036_1xC
Battery:BatteryHolder ComfortableElectronic_CH:
Battery:BatteryHolder_Eagle 12BH611-GR
Battery:BatteryHolder_ Keystone_103_lx20mm
Battery:BatteryHolder_ Keystone_104_lx23mm
Battery:BatteryHolder_ Keystone_105_1x2430

Battery:BatteryHolder_ Keystone_l 1x20mm

Battery:BatteryHolder_ Keystone_.
Battery:BatteryHolder_Keystone_500
Battery:BatteryHolder Keystone_1042_1x18650
Battery:BatteryHolder Keystone_1058_1x2032
Battery:BatteryHolder Keystone_l060_1x2032
Battery:BatteryHolder Keystone_ 2460_lxAR
Battery:BatteryHolder_Keystone_ 2462_2xAAR
Battery:BatteryHolder_ Keystone_2466_lxAAR
Battery:BatteryHolder_ Keystone_ 246S_2xARA

_1x23mm

Battery:BatteryHolder_Keystone_2479_3xAAR
Battery:BatteryHolder_ Keystone_2993
Battery:BatteryHolder_ Keystone_2995_l1x6.Smm
Battery:BatteryHolder_ Keystone_3000_lx12mm
Battery:BatteryHolder Keystone_3001_lx12mm
Battery:BatteryHolder_Keystone_3002_1x2032
Battery:BatteryHolder Keystone_3008_1x2450
Battery:BatteryHolder_Keystone_3009_1x2450

Cancel
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EJEMPLO EN KICAD

B ‘ a2 \ Grid: 0.0100in (02540 mm) v

Zoom Auto v

8 3D Viewer

RN

File Edit View Preferences Help

_ SR RS ACHCRONE B SRV AN -

ceee
P seee
@ seea

PP

i B

3
3

7
x: 0.0000 In | [ REF**

y: 0.1000 In F2
re 0.1000 in
B: —90.0 deg

FNNO |+

<
REF** Status: Rotation Footprint: DIP-8
DIP-8_W7.62mm Attributes: 0 3D-Shape: ${KIC

.62mm Doc: 8-lead though-hole mounted DIP package, row spacing 7
6_3DMODEL_DIR}/Package_DIP.3dshapes/DIP-8_ W7.62mm.wrl Keywords: THT DIP DIL PDIP 2.54mm 7.62mm 300mil
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EJEMPLO EN KICAD

S Q Q @ Q ! ! Grid: 0.0100 in (0.2540 mm) v ||| Zoom Auto v

8 3D Viewer

File Edit View Preferences Help

B R@Cara@hk

1 I
Lt |2 2

|

<
REF** Status: Rotation Footprint: TO-92_Inline Doc: TO-92 leads in-line, narrow, oval pads, drill 0.75mm (see NXP sot054_po.
0-92_Inline Attributes: 0 3D-Shape: ${KICAD6_3DMODEL_DIR}/Package_TO_SOT_THT.3dshapes/TO-92_Inline.wrl Keywords: to-92 sc-43 sc-43a sot54 PA33 transistor

X SEMINARIO DE @ ¢

AUTOMATICA

27 AL 30 DE SEPTIEMBRE

universidad
de excelencia
y solidaria del Cauca




X SEMINARIO DE

AUTOMATICA

27 AL 30 DE SEPTIEMBRE

EJEMPLO EN KICAD

®R ‘ B | [Gic:00100in 02580mm) v ||[ZoomAuto

8 3D Viewer

File Edit View Preferences Help

B PRI CQAQ@|[Ye || 2]

vee
\ es
) e

3 =

!

E

x: 0.1000 in
: 0.0000 In

LE DﬂD 3. OE":\"_"%?#‘L:;

BNRE |~

<
REF** Status: Rotation Footprint: LED_D3.0mm Doc: LED, diameter 3.0mm, 2 pins
LED_D3.0mm Attributes: 0 3D-Shape: ${KICAD6_3DMODEL_DIR}/LED_THT.3dshapes/LED_D3.0mm.wrl Keywords: LED diameter 3.0mm 2 pins

universidad
de excelencia
y solidaria

» : o @
x S 5
Universidad
del Cauca



EJEMPLO EN KICAD

@ Q @ l! ‘ Grid: 0.0100 in (0.2540 mm) v Zoom Auto v

8 3D Viewer

SE QY

File Edit View Preferences Help

_ NS AFSACRCRONR L AP 2 E BRI 2% o 3

s [

2

£

»+

FNNO|

Last render time 16 ms

< >
REF** Status: Rotation Footprint: TerminalBlock_Phoenix_MKDS-1,5-2-5.08_1x02_P5.08mm_Horizontal
TerminalBlock_Phoenix_MKDS-1,5-2-5.08_1x02_P5.08mm_Horizontal Attributes: 0 3D-Shape: ${KICAD6_3DMODEL_DIR}/TerminalBlock_Phoenix.3dshapes/TerminalBlock_Phoenix_MKDS-1,5-2-5.08_1x02_P5.08mm_Hc
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EJEMPLO EN KICAD

@ ® ‘ B | [Gid:0010in 0250 mm) v ||[zoom Auto +

8 3D Viewer

File Edit View Preferences Help

B PP CRAQE | e e fst | %

x:40.2100 In
y+ 0.0000 in
r: 0.2100 In
6: —0.0 deg

CP_Radial_D8.0mm_P5.00mm

< >
REF* Status Rotation Footprint: CP_Radial P Doc: CP, Radial series, Radial, pin pitch=5.00mm, , diameter=8mm, Ele
CP_Radial_D8.0mm_P5.00mm Attributes: 0 3D-Shape: ${KICAD6_3DMODEL_DIR}/Capacitor_THT.3dshapes/CP_Radial_D8.0mm_P5.00mm.wrl Keywords: CP Radial series Radial pin pitch 5.00mm diameter 8mm El
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EJEMPLO EN KICAD

Q Q @ ® ‘ B |[crid:00100in 02500 mm) v | ZoomAute

S > Q¥

8 3D Viewer

I

File Edit View Preferences Help

Bh RS CAQR | M |l

2

5

x: 0.3000 In

y: 00000 in
m_D2. Smrr_w,00 Ime

8: —0.0 deg

JBNNGS |+

m
™
o

Status: Rotation Footprint: R

E 6.3mm_D2.5mm_P7.62mm_Horizontal
R_Axial_DINO2 3mm_D2.5mm_P7.62mm_Horizontal Attributes: 0 3D-Shape: ${KI

3DMODEL_DIR}/Resistor_THT.3dshapes/R_Axial_DIN0207_L6.3mm_D2.5mm_P7.62mm_Horizontal.wrl
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EJEMPLO EN KICAD

Tools -> Assign Footprints

b Assign Footprints - ] X
File Edit Preferences Help

B[ DD C % % | reowmmms [ —
Footprint Libraries Symbol : Footprint Assignments Filtered Footprints
Audio_Module A 1 Cri= 10n : Capacitor THT:C Disc_D4.3mm Wl.9mm PS.00mm
Battery 2 c2 - lu : Capacitor THT:CP_Radial DS.0mm_P2.50mm
Button_Switch_Keyboard 3 Dl - 1N4148 : Diode_THT:D_DO-35_SOD27_P7.62mm Horizontal
Button_Switch_SMD 4 D2 - 1N4148 : Diode_THT:D_DO-35_SOD27_P7.62mm Horizontal
Button_Switch_THT 5 D3 - LED : LED_THT:LED_D3.Omm
Buzzer_Beeper € Jl - Screw_Terminal 01x02 : TerminalBlock Phoenix:TerminalBlock Phoenix MKDS-1,5-2-5.08]
Calibration_Scale 7 POT1 - 500k : Potentiometer THT:Potentiometer_Vishay 248BH-249BH_Single_Horiz¢
Capacitor_SMD 8 Q1 - PN22227 : Package_TO_SOT_THT:T0-92_Inline
Capacitor_Tantalum SMD 9 Rl - 1k : Resistor THT:R Axial DIN0207_L€.3mm D2.5mm P7.€2mm Horizontal
Capacitor_THT 10 R2 - 1k : Resistor THT:R Axial DIN0207 Lé.3mm D2.5mm_P7.62mm Horizontal
Connector 11 Ul - NESSSP : Package_ DIP:DIP-8_W7.é2mm
Connector_AMASS
Connector_Amphenol
Connector_Audio
Connector_BarrelJack
Connector_Card
Connector_Coaxial
Connector_DIN
Connector_Dsub
Connector_FFC-FPC
Connector_Harting
Connector_Harwin
Connector_HDMI
Connector_Hirose
Connector_IDC
Connector_JAE %
< > < > < >
Filtered by Keywords (C_*), Pin Count (2), Library (Audio_Module): 0
Library location: C:\Program Files\KiCad\6.0\share\kicad\footprints\/Capacitor_THT.pretty

Apply, Save Schematic & Continue Cancel
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EJEMPLO EN KICAD

a PWM555 — PCB Editor = X

File Edit View Place Route Inspect Tools Preferences Help
A B 06M PlCaaRe s {2 |3 o [mrcewn ]

Track: use netclass width v LT_J Via: use netclass sizes v ‘ Grid: 0.2500 mm (0.0098 in) v || Zoom Auto v

Appearance
Layers  Objects Nets
»E O Fcu A

[ NoX:Xdl

M O F.Adhesive

|| e B.Adhesive
Q F.Paste

M & Braste
e F.Silkscreen
© Bsilkscreen
® FMask
® BMask

Q User.Drawings
| e User.Comments

e User.Eco1
Q User.Eco2
Q Edge.Cuts
= o Margin
= Q F.Courtyard

P
» Layer Display Options

Bl IXE

v

Presets (Ctrl=Tab):
All Layers v

Selection Filter

All items Locked items
Footprints M Text

Vias
raphics
Zones Rule Areas
4 [ Dimensions  [] Other items

YOO\ |&zh

Pads Vias Track Segments Nets Unrouted
0 0 0 0 0

Z0.65 X215.2500 Y 13.2500 dx 215.2500 dy 13.2500 dist 215.6574 grid X 0.2500 Y 0.2500 mm e
3

o,
Ny,
£
B3
i

;
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EJEMPLO EN KICAD

Tools -> Update PCB from Schematic

X SEMINARIO DE

AUTOMATICA

27 AL 30 DE SEPTIEMBRE

Update PCB from Schematic

Options
[JiRe-link footprints to schematic symbols based on their reference designators:

[[] Delete footprints with no symbols
Replace footprints with those specified in the schematic

Changes To Be Applied
AQd UZ (TOOTPMNT wioae_IH1U_UU-35_DUUZI_F (. bzmm_ronzontal ).

Add D3 (footprint LED_THT:LED_D3.0mm’).

Add J1 (footprint TerminalBlock_Phoenix:TerminalBlock_Phoenix_MKDS-1,5-2-5.08_1x02_P5.08mm_Hor
Add POT1 (footprint ‘Potentiometer_THT:Potentiometer_Vishay 248BH-249BH_Single_Horizontal’).

Add Q1 (footprint 'Package_TO_SOT_THT:TO-92_Inline’).

Add R1 (footprint ‘Resistor_THT:R_Axial_DIN0207_L6.3mm_D2 5mm_P7.62mm_Horizontal’).

Add R2 (footprint ‘Resistor_THT:R_Axial_DIN0207_L6.3mm_D2 5mm_P7.62mm_Horizontal’).

Add U1 (footprint '‘Package_DIP:DIP-8_W7.62mm’).

Total warnings: 0, errors: 0.

< >

Show: [“] All [“] Errors o Warnings n [+] Actions ] Infos Save...

Update PCB Close
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EJEMPLO EN KICAD

I *PWM555 — PCB Editor o X

File Edit View Place Route Inspect Tools Preferences Help

ABLDBRSC|IAICRAARQ Q|8 0o (ld | o (W -Hll|E S

Track: use netclass width v LT_J Via: use netclass sizes || Grid: 0.2500 mm (0.0098 in) v ‘ Zoom Auto v

Appearance
Layers Objects Nets
4 Noldd A

[_No):Xdl

M © F.Adhesive

B © BAdhesive
e F.Paste

© BPaste
o F.Silkscreen
© Bsilkscreen
© FMask
® BMask
o User.Drawings

M & User.Comments
e User.Ecol
o User.Eco2
Q Edge.Cuts

= e Margin

M & F.courtyard
Ao

» Layer Display Options

ERED

Presets (Ctrl+=Tab):
All Layers 0

Selection Filter

YOO N\ &zh

All items Locked items
Footprints Text
M Tracks Vias
e Pads Graphics
: % [“]zones [ Rule Areas
b2 > 4 Dimensions Other items
Pads Vias Track Segments Nets Unrouted
30 0 0 10 20
Z0.98 X 149.5000 Y -3.2500 dx 149.5000 dy -3.2500 dist 149.5353 grid X 0.2500 Y 0.2500 mm Select item(s)
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EJEMPLO EN KICAD

Appearance
Layers Objects Nets

» @ F.Cu A
| No Xt

Silkscreen B O FAdnesive

B © BAdhesive

W O F.Paste
Soldermask M O Braste

@ F.Silkscreen

@ B.Silkscreen

Copper M O F.Mask
W O BMask

@ User.Drawings
M © User.Comments

Substrate (FR4)

@ User.Ecol
@ User.Eco2
@ Edge.Cuts
X SEMINARIO DE @ G M O Margin
AUTOMATICA o~ |¢ M O F.courtyard 5
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EJEMPLO EN KICAD

Board Setup

[=- Board Stackup

-- Board Editor Layers
® Physical Stackup

- Board Finish

.. Solder Mask/Paste
(=)~ Text & Graphics

- Defaults

- Text Variables

= Design Rules

-. Constraints

- Pre-defined Sizes
- Net Classes

.. Custom Rules

- Violation Severity

Import Settings from Another Board...

Copper layers: |12 [JImpedance controlled Add Dielectric Layer...

Remove Dielectric Layer...

X

Layer Id Type Material Thickness a Color EpsilonR Loss Tan

mmmm FSilkscreen Top Silk Screen
F.Paste Top Solder Paste

mmm FMask  TopSolderMask | Notspecified |..| [0.01mm | | Notspecifiec~| [33 | ]o0 |
F.Cu Copper @

mmmm Diclectric1 | Core v| [Fra .| [151mm |O 45 | [002 ]
B.Cu Copper

mmm BMask  Bottom Solder Mask | Notspecified .. |0.01 mm | [ENotspecifiec v | [33 |0 ]

B.Paste Bottom Solder Paste

mmmm B.Silkscreen Bottom Silk Screen Not specified [l Not specifiec v

Board thickness from stackup: Adjust Dielectric Thickness

Export to Clipboard

Cancel
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EJEMPLO EN KICAD

Board Setup X
- Board Stackup Net Class Clearance | Track Width | Via Size Via Hole pViaSize | uViaHole | DP Width DP Gap
i Board Editor Layers| P = e irs [P : = 1a- : [Fer
. Physical Stackup
. Board Finish
.. Solder Mask/Paste
(=) Text & Graphics
.. Defaults
i... Text Variables =
=) Design Rules 2 L
... Constraints e
.. Pre-defined Sizes o 5_ Net Net Class
Net class filter: v Defau
- Custom Rules Net name filter: /DIS Default
‘.. Violati i
iolation Severity 1 Defaill
Show All Nets Apply Filters /R Default
GND Default
Net-(D1-Pad1) Default
Net-(D2-Pad2) Default
Net-(D3-Pad1) Default
Assign Net Class Net-(D3-Pad2) Default
New net class: N VCC Default
Assign To All Listed Nets Assign To Selected Nets
Import Settings from Another Board... Cancel
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EJEMPLO EN KICAD

View -> 3D Viewer

8 3D Viewer - O X
File Edit View Preferences Help

5 B CRQA |kl |2 B st
1. Board outline is missing or malformed. Run DRC for a full analysis. @

POT1

X SEMINA,RIO )| Last render time 0 ms 7
AUTOMATICA e o et Universidad
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EJEMPLO EN KICAD

. k Layers Objects Net
Place -> Draw Line (Edge.Cuts ) By o E=ciE

>< | Jo XX A
. m@®saw
i:] B & F.Adhesive
M & B.Adhesive

/_/ & F.Paste

4 M © BPaste
JUL-

4

@ F.Silkscreen
@ B.Silkscreen

& FMask
& BMask
E & User.Drawings

M © user.Comments
Q User.Eco1
_~

l: 20.000 mm

M & r.courtyard

A [ 2 B SRR SRS v
. : » Layer Display Options
crew_lerminal_Dlxg2 141548

sl s el 1 Presets (Ctrl=Tab):

O All Layers
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EJEMPLO EN KICAD

Place -> Draw Arc (Edge.Cuts ) Layers  Objects Nets

| JoXd A
| JoJ:Ad
B & F.Adhesive
M & B.Adhesive
& F.Paste
M O BPaste
@ F.Silkscreen
@ B.Silkscreen

& F.Mask
& BMask

@ User.Drawings
M © user.Comments

@ User.Ecol
_—~

&4 Q F.Courtyard

7 R ¥
Layer Display Options

Presets (Ctrl=Tab):

O All Layers v
v |3
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EJEMPLO EN KICAD

m PWMS555 — PCB Editor

File Edit View Place Route Inspect JTools Preferences Help
AEBDEMOC|IAICRAQARR A |0 Bd|lgh %k 0w M E &

Track: use netclass width v Lf_] ‘ Via: use netclass sizes v ‘ Grid: 1.0000 mm (0.0394 in) v ‘ Zoom Auto v
|

A Appearance
Layers Objects Nets

O rcu ~
[ NoX:Xat
B O F.Adhesive
M O BAdhesive
& F.paste
M © BPaste
@ F.Silkscreen
Q B.Silkscreen
& F.Mask
® BMask
e User.Drawings
M © user.Comments
e User.Ecol
e User.Eco2
» ® Edge.Cuts
M O Margin
M O F.Courtyard

P SR
» Layer Display Options

Bl IXE

Presets (Ctrl=Tab):
All Layers s

Selection Filter

[ Al items Locked items
Footprints  [V] Text

Y=Y OO\ &zh

Tracks Vias
Pads Graphics
v|i$ Zones Rule Areas
< > 4 7] Dimensions [ Other items
Pads Vias Track Segments Nets Unrouted
30 0 0 10 20
File 'C:\Users\Nando Hurtado\Documents\KiCAD\P... = Z3.87 X 91.0000 Y 37.0000 dx 91.0000 dy 37.0000 dist 98.2344 grid X 1.0000 Y 1.0000 mm Select item(s)
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EJEMPLO EN KICAD
@:c IPC-2221A

ASSOCIATION CONNECTING
/-ELE-':!RONICS INDUSTRIES *

Generic Standard on

Las normas IPC son una herramienta guia de las
Printed Board Design

mejores practicas de diseno, fabricacion,
ensamble e inspeccion de PCB. Al aplicarlas
ayudan a alcanzar altos niveles de calidad,
optimizar el proceso completo de manufactura,
reducir el tiempo de lanzamiento al mercado vy
obtener un producto con mejor desempeno.
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EJEMPLO EN KICAD

@ IPC-2221A

ASSOCIATION CONNECTING
/_ELEC TRONICS INDUSTRIES *

Generic Standard on

: Printed Board Design
Ancho de Corriente

pista (Amperios)
(mm)

Voltaje Distancia
0-15 0.2 mm

025 0.3 ‘
0.38 04 | 15-50 0.4mm-1mm |

' ' 50-120 8-10mmo
0.8 1A
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EJEMPLO EN KICAD

Board Setup

=)- Board Stackup

- Board Editor Layers
- Physical Stackup

- Board Finish

- Solder Mask/Paste
[=- Text & Graphics

- Defaults

. Text Variables

=) Design Rules

- Constraints

.. Pre-defined Sizes
... Custom Rules

- Violation Severity

Assign To All Listed Nets

Import Settings from Another Board...

Assign To Selected Nets

oK

Net Class Clearance | Track Width Via Size Via Hole pVia Size uVia Hole DP Width DP Gap
+ |W
Filter Nets Net Net Class
Net class filter: v = Defaul
Net name filter: /DIS Default
/Q Default
Show All Nets Apply Filters R Default
GND Default
Net-(D1-Pad1) Default
Net-(D2-Pad2) Default
Net-(D3-Pad1) Default
Assign Net Class Net-(D3-Pad2) Default
New net class: v vVCC Default

Cancel

> G %

universidad
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EJEMPLO EN KICAD

Board Setup X
- Board Stackup NetClass | Clearance | TrackWidth | ViaSize | ViaHole | pViaSize | uViaHole | DPWidth | DPGap
~Board Editor Layers i 1 r. ¢ 02 mm 025mm  08mm 04 mm 03 mm 0.1 mm 02 mm 0.25 mm
- Physical Stackup R d - i Ko L ya——— b
- Board Finish | | 0.2 mm ‘
.. Solder Mask/Paste Power 1mm 1mm 1.6 mm 0.8 mm 0.3 mm 0.1 mm 0.2 mm 0.25 mm
=- Text & Graphics
- Defaults
.. Text Variables -
[=- Design Rules + L
... Constraints Filter Net
.. Pre-defined Sizes S S' Net | NetClass
i Net class filter: v /v Data
- Custom Rules Net name filter: /DIS Data
- Violation Severity 1 Tt
Show All Nets Apply Filters R Data
GND Power
Net-(D1-Pad1) Data
Net-(D2-Pad2) Data
Net-(D3-Pad1) Data
Assign Net Class Net-(D3-Pad2) Data
New net class: v VCC m
Assign To All Listed Nets Assign To Selected Nets
Import Settings from Another Board... Cancel
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EJEMPLO EN KICAD

.oy
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50.000C mm
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EJEMPLO EN KICAD

X SEMINARIO DE @ G %
AUTO MATI CA {f(&_‘,// ! , : universidad U

; de excelencia
97, e .
27 AL 30 DE SEPTIEMBRE //O‘/{ 7108 | i y solidaria del Cauca

Por una




EJEMPLO EN KICAD

File -> Fabrication Outputs -> Gerber

Plot

Plot format: | Gerber

Include Layers

Output directory: ’ Gerber/

General Options

F.Cu [JPlot border and title block Drill marks: None

E/E:;h y Plot footprint values Scaling: 111
Adhesive

[]B.Adhesive Plot reference designators Plot mode: Filled

; [;:S:tz [[JForce plotting of invisible values / refs [[] Use drill/place file origin

F.Silkscreen [[]Plot Edge.Cuts on all layers Mirrored plot

] B.Silk:

F N;asskcreen [[] Sketch pads on fabrication layers Negative plot

B.Mask [J Do not tent vias Check zone fills before plotting

[JUser.Drawings

[ User.Comments Gerber Options

[1bsesiEcod [] Use Protel il ; Coordinate format: [4,6, uni

DUser.ECOZ se Protel filename extensions oordinate format: ' 4.6, unit mm

Edge.Cuts Generate Gerber job file Use extended X2 format (recommended)

[ Margin

CIF Cogurtyard [[] Subtract soldermask from silkscreen Include netlist attributes

g B.Courtyard v [[] Disable aperture macros (not recommended)

Output Messages

x SEMINAHIO DE (@ c & Show: [JAll Merors @I [MWamings @ [ Actions [ Infos Save...
AUTO MATI CA V= . Run DRC... (2 known DRC violations; 0 exclusions) Close

Generate Drill Files... Ppiversioad

de excelencia Universidad
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EJEMPLO EN KICAD

/

S
=

C JL CPCB Why JLCPCB? Capabilities Support Resources Order now My file Sign in @

(

PCB Charge Details

Special Offer $2.00
Detected 2 layer board of 30x50mm(1.18x1.97 inches) .

finished processing. Enter the project details below and we'll move on to checking all the individual layers tc Build Time

PCB: @ 1-2days $0.00

Weight 0.13kg
SAVE TO CART
Shipping Estimate $7.12

v Standard Global Direct Line  12-20 business days

W
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iGracias por su atencion!
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